This guide is for use with TeamBoard Suite 6.

Revised March 2012.

TeamBoard is a registered trademark of Egan TeamBoard Inc.

All products or companies mentioned are trademarks or service marks of their respective owners.

© 1994-2012 Egan TeamBoard Inc. All Rights Reserved
Table of Contents
Chapter 1 – Accessing Help Resources ........................................................................... 2
  Help Resources Available ............................................................................................... 2
  Contacting TeamBoard Technical Support ................................................................. 2
  Common Solutions........................................................................................................ 2
  Contacting TeamBoard Technical Support .................................................................. 3
Chapter 2 – Setting Up TeamBoard ..................................................................................... 4
  Setting up TeamBoard Hardware ................................................................................... 4
    TeamBoard H-Series USB or TeamBoard 3 VRT ......................................................... 4
    TeamBoard Finger Touch Monitor ............................................................................. 5
    TecTern and TecTernTwo with TeamBoard Finger Touch Monitor ......................... 6
    TeamBoard IR ........................................................................................................... 7
  Before Installing TeamBoard Suite ............................................................................... 8
    Does your Computer Meet the Minimum Performance Requirements? ................ 8
    Do you have the Required Prerequisite Software Installed? ................................ 8
    Is Your Computer Ready to Install TeamBoard Suite? ........................................... 8
  Installing TeamBoard Suite ......................................................................................... 9
    Windows 8 ............................................................................................................. 9
    Windows 7 ............................................................................................................. 11
    Windows Vista ....................................................................................................... 13
    Windows XP ........................................................................................................... 15
Chapter 3 – TeamBoard Menus ........................................................................................ 18
  TeamBoard System Tray Menu .................................................................................... 18
  TeamBoard Start Menu Folder .................................................................................... 19
  TeamBoard Dashboard ................................................................................................. 21
Chapter 4 – Calibration .................................................................................................... 22
  About Calibration ........................................................................................................ 22
  Calibrating TeamBoard on Windows Systems ............................................................ 23
    Whiteboard Calibration ......................................................................................... 23
    ActionBar Calibration ............................................................................................. 26
    Interactive Calibration ............................................................................................ 29
    Pressure Calibration ............................................................................................... 32
Chapter 5 – TeamBoard Draw Interface .......................................................................... 37
  Opening TeamBoard Draw .......................................................................................... 37
## TeamBoard Draw Interface for TeamBoard H-Series USB, TeamBoard IR, and TeamBoard Touch Monitor

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars</td>
<td>39</td>
</tr>
<tr>
<td>Standard Toolbar</td>
<td>39</td>
</tr>
<tr>
<td>Custom Toolbar</td>
<td>40</td>
</tr>
<tr>
<td>Drawing Toolbar</td>
<td>41</td>
</tr>
<tr>
<td>TeamBoard 3 VRT Draw Interface</td>
<td>48</td>
</tr>
<tr>
<td>Toolbars</td>
<td>48</td>
</tr>
<tr>
<td>Standard Toolbar</td>
<td>49</td>
</tr>
<tr>
<td>Custom Toolbar</td>
<td>50</td>
</tr>
<tr>
<td>Drawing Toolbar</td>
<td>50</td>
</tr>
<tr>
<td>Dual Toolbar</td>
<td>51</td>
</tr>
<tr>
<td>Chapter 6 – TeamBoard ActionBar</td>
<td>58</td>
</tr>
<tr>
<td>ActionBar Explained</td>
<td>58</td>
</tr>
<tr>
<td>ActionBar in Whiteboard Mode</td>
<td>59</td>
</tr>
<tr>
<td>Interactive Mode in TeamBoard Draw</td>
<td>60</td>
</tr>
<tr>
<td>Chapter 7 – Using TeamBoard Draw with a TeamBoard</td>
<td>61</td>
</tr>
<tr>
<td>Using TeamBoard Draw and a TeamBoard without a Projector</td>
<td>61</td>
</tr>
<tr>
<td>Switching to Whiteboard Mode</td>
<td>61</td>
</tr>
<tr>
<td>Drawing and Writing on the TeamBoard</td>
<td>62</td>
</tr>
<tr>
<td>Erasing Drawings and Writing</td>
<td>63</td>
</tr>
<tr>
<td>Other Functionality in Whiteboard Mode</td>
<td>63</td>
</tr>
<tr>
<td>Using TeamBoard Draw and a TeamBoard with a Projector</td>
<td>64</td>
</tr>
<tr>
<td>Switching to Interactive Mode</td>
<td>64</td>
</tr>
<tr>
<td>Chapter 8 – Essential TeamBoard Draw Functions</td>
<td>65</td>
</tr>
<tr>
<td>Drawing Stuff</td>
<td>65</td>
</tr>
<tr>
<td>Using Pens</td>
<td>65</td>
</tr>
<tr>
<td>Using Arrows</td>
<td>66</td>
</tr>
<tr>
<td>Drawing Shapes</td>
<td>68</td>
</tr>
<tr>
<td>Entering Text</td>
<td>71</td>
</tr>
<tr>
<td>Cut, Copy, Paste and Moving Objects</td>
<td>74</td>
</tr>
<tr>
<td>Moving Content</td>
<td>74</td>
</tr>
<tr>
<td>Copying, Cutting, and Pasting Content</td>
<td>74</td>
</tr>
<tr>
<td>Working with Multiple Pages</td>
<td>77</td>
</tr>
<tr>
<td>Creating a New, Blank Page</td>
<td>77</td>
</tr>
</tbody>
</table>
Creating a Copy of a Page .................................................................................................................. 78
Deleting a Page ................................................................................................................................. 78
Using the Page Sorter ......................................................................................................................... 78
Viewing Pages ..................................................................................................................................... 80
Saving Your Work .............................................................................................................................. 81
Manually Saving.................................................................................................................................. 81
Auto Save ........................................................................................................................................... 82
Exporting a Page or Workbook .......................................................................................................... 84
Supported Export Formats ................................................................................................................. 84
Exporting your Current Page .............................................................................................................. 84
Exporting the TeamBoard Workbook ............................................................................................... 86
Printing Your Work ............................................................................................................................. 87
Print Preview ....................................................................................................................................... 87
Printing .................................................................................................................................................. 88
Advanced Printing .............................................................................................................................. 89
Full Screen Mode ................................................................................................................................. 90
Opening Full Screen Mode .................................................................................................................. 90
Full Screen Drawing Toolbar ............................................................................................................. 90
Clipart ................................................................................................................................................... 91
Opening ClipArt Viewer ..................................................................................................................... 91
Adding a Category to ClipArt Viewer ................................................................................................. 92
Importing an Image into ClipArt Viewer ............................................................................................ 93
Deleting a Category ClipArt Viewer ................................................................................................... 96
Moving Clipart Viewer ....................................................................................................................... 96
Closing ClipArt Viewer ....................................................................................................................... 97
Spotlight .............................................................................................................................................. 98
Opening the Spotlight ....................................................................................................................... 98
Adjusting the Spotlight ...................................................................................................................... 98
Changing the Spotlight Shape ........................................................................................................... 99
Changing the Spotlight Background Colour ....................................................................................... 100
Using Hide/Reveal ............................................................................................................................ 103
Inserting Backgrounds ....................................................................................................................... 103
Inserting Background from File ......................................................................................................... 103
Insert Background Colour .................................................................................................................. 105
Deleting an Imported Background Image ........................................................................................... 107
Chapter 1 – Accessing Help Resources

Help Resources Available
You can obtain help with your TeamBoard from the following places:

- The Quick Start Guide
  - A document containing quick reference information.
    - The Quick Start guide can be found (as shipped) in the envelope on the back of the TeamBoard.
    - Online – teamboard.com/support/documentation.html
    - TeamBoard Suite DVD

- Picture in Picture Tutorials
  - Tutorials that demonstrate how to use the most common Draw tools
    - Online – teamboard.com/support/tutorials.html
    - TeamBoard Draw – page 40

- Frequently Asked Questions
  - A list of commonly asked questions and answers for those questions
    - Online – teamboard.com/support/faq.html

Contacting TeamBoard Technical Support

Common Solutions

Below is a checklist of common solutions that may quickly resolve your issue. Before contacting TeamBoard Technical Support, ensure that you have answered all these questions.

Have you done the following?

- Looked for your question in the frequently asked questions?
  - teamboard.com/support/faq.html
- Checked that all cable connections are secure and connected?
  - Page 4
- Installed the latest TeamBoard Suite?
  - You can get the latest TeamBoard Suite software from our website
    - teamboard.com/support/software.html
  - Page 9
- Performed Whiteboard calibration, ActionBar calibration, Interactive calibration and Pressure Calibration (TeamBoard 3 VRT only)?
  - Page 22
Contacting TeamBoard Technical Support

If you continue to have an issue, please contact TeamBoard Technical Support:

Support Form  teamboard.com/technical-support-form.html

Mail      Egan TeamBoard Inc.
          300 Hanlan Road
          Woodbridge, Ontario
          Canada L4L 3P6

Phone     Monday to Friday, 0800 to 2000 EST
          1 (800) 263 2387

Fax       1 (905) 851 3426
Chapter 2 – Setting Up TeamBoard

Setting up TeamBoard Hardware

TeamBoard H-Series USB or TeamBoard 3 VRT

**Important** If you are not using the supplied RJ45 cable you must use one that is shielded with connectors that are grounded and is no longer than 25 feet; if a longer distance is required, please contact TeamBoard Technical Support (page 2.)

1) Plug one end of the RJ45 cable into the USB Adapter.
2) Plug the other end of the RJ45 cable into the TeamBoard Controller (located on the back of the TeamBoard, in the bottom-right corner).
TeamBoard Finger Touch Monitor

1) Connect a VGA or DVI cable to the correct port
2) Connect the power cord
3) Plug the VGA or DVI cable into your computer
4) Plug the power cord into an electrical outlet
5) Press the power button to turn on the monitor
TecTern and TecTernTwo with TeamBoard Finger Touch Monitor

1) Connect a VGA cable to the VGA port
2) Connect the power cord
3) Plug the VGA cable from the monitor into the Output port of the splitter
4) Plug a VGA cable into the Input port on the splitter
5) Plug the VGA cable (from the input port) into your computer
6) Plug the USB cable from the splitter into a USB port on your computer
7) Plug the power cord into the power bar supplied with the TecTern or TecTernTwo
8) Plug the power bar cord into an electrical outlet
9) Press the power button to turn on the monitor
TeamBoard IR

Important  If you are not using the supplied RJ45 cable you must use one that is shielded with connectors that are grounded and is no longer than 25 feet; if a longer distance is required, please contact TeamBoard Technical Support (page 2.)

1) Plug one end of the RJ45 cable into the USB Adapter.
2) Connect the power cable to the power adapter
3) Plug the other end of the RJ45 cable into the IR connector on the board.
4) Plug the other end of the power adapter to the board
Before Installing TeamBoard Suite

**Important** Please read the ReadMe Notice available on the installation DVD or on teamboard.com/support/documentation. It contains important information about the software.

Does your Computer Meet the Minimum Performance Requirements?

**Minimum Requirements**

<table>
<thead>
<tr>
<th>Operating System</th>
<th>RAM</th>
<th>Hard Drive Free Space</th>
<th>Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 8</td>
<td>1GB</td>
<td>300MB</td>
<td>Pentium 4 or greater</td>
</tr>
<tr>
<td>Windows 7</td>
<td>1GB</td>
<td>300MB</td>
<td>Pentium 4 or greater</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>1GB</td>
<td>300MB</td>
<td>Pentium 4 or greater</td>
</tr>
<tr>
<td>Windows XP</td>
<td>1GB</td>
<td>300MB</td>
<td>Pentium 4 or greater</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>1GB</td>
<td>300MB</td>
<td>Intel Processor</td>
</tr>
<tr>
<td>Linux</td>
<td>1GB</td>
<td>300MB</td>
<td>Pentium 4 or greater</td>
</tr>
</tbody>
</table>

Do you have the Required Prerequisite Software Installed?

- Apple QuickTime - apple.com/quicktime
  - Required to play supported movie files, except .swf

Is Your Computer Ready to Install TeamBoard Suite?

- Have you closed all other applications?
- Have you logged into an account with administrative rights (Windows only)?
Installing TeamBoard Suite

Windows 8

Important  Install TeamBoard Suite before connecting the USB adapter

1) Insert the TeamBoard Suite DVD into your computer’s DVD drive.

2) Determine whether your computer is running a 32-bit version or 64-bit version of Windows.
   ▪ To determine which operating system version you have:
     1) Click Start
     2) On the Start screen type **System Information** (the search box will appear) and then click **System Information** under Apps.
     3) Your operating system will appear as follows:
        a) If **x64-based PC** appears beside **System Type** you have a 64 bit version of Windows and should install setup64.exe
           
           System Type                  x64-based PC
        b) If **X86-based PC** appears beside **System Type** you have a 32 bit version of Windows and should install setup32.exe
           
           System Type                  X86-based PC

3) Select and open the correct installer

*The Welcome screen displays.*
4) On the Welcome screen verify your controller is supported. Then click install.

**Note:** If you are not sure which controller you have, check the label on the controller (located on the back of the TeamBoard). If you are unable to find the label or are still unsure contact Technical Support (page 2.)

*TeamBoard Suite installs.*

5) Once TeamBoard Suite has finished installing it will display the Install Successful screen. Click *Close*.

*TeamBoard Suite has been installed successfully.*

6) Restart your computer

7) Plug the USB adapter into a USB port on your computer.

**Important** You should now complete all calibrations (page 22.)
**Windows 7**

**Important** Install TeamBoard Suite before connecting the USB adapter

1) Insert the TeamBoard Suite DVD into your computer’s DVD drive.

2) Determine whether a computer is running a 32-bit version or 64-bit version of Windows.
   - To determine which operating system version you have:
     a. Click Start
     b. In the *Search programs and files* box type *System Information*, and then click System Information in the Programs list.
     c. Your operating system will appear as follows:
        i. If **x64-based PC** appears beside **System Type** you have a 64 bit version of Windows and should install setup64.exe
        System Type x64-based PC
        ii. If **X86-based PC** appears beside **System Type** you have a 32 bit version of Windows and should install setup32.exe
        System Type X86-based PC

3) Select and open the correct installer

*The Welcome screen displays.*
4) On the Welcome screen verify your controller is supported. Then click install.

**Note:** If you are not sure which controller you have, check the label on the controller (located on the back of the TeamBoard). If you are unable to find the label or are still unsure contact Technical Support (page 2.)

*TeamBoard Suite installs.*

5) Once TeamBoard Suite has finished installing it will display the Install Successful screen. Click Close.

*TeamBoard Suite has been installed successfully.*

6) Restart your computer

7) Plug the USB adapter into a USB port on your computer.

**Important** You should now complete all calibrations (page 22.)
Windows Vista

Important  Install TeamBoard Suite before connecting the USB adapter

1) Insert the TeamBoard Suite DVD into your computer’s DVD drive.

2) Determine whether a computer is running a 32-bit version or 64-bit version of Windows.
   • To determine which operating system version you have:
     a. Click Start
     b. In the Start Search box type System Information, and then click System Information in the Programs list.
     c. Your operating system will appear as follows:
        i. If x64-based PC appears beside System Type you have a 64 bit version of Windows and should install setup64.exe
           System Type  x64-based PC
        ii. If X86-based PC appears beside System Type you have a 32 bit version of Windows and should install setup32.exe
            System Type  X86-based PC

3) Select and open the correct installer

   The Welcome screen displays.
4) On the Welcome screen verify your controller is supported. Then click install.

**Note:** If you are not sure which controller you have, check the label on the controller (located on the back of the TeamBoard). If you are unable to find the label or are still unsure contact Technical Support (page 2.).

*TeamBoard Suite installs.*

![](image)

5) Once TeamBoard Suite has finished installing it will display the Install Successful screen. Click Close.

*TeamBoard Suite has been installed successfully.*

![](image)

6) Restart your computer

7) Plug the USB adapter into a USB port on your computer.

**Important** You should now complete all calibrations (page 22.)
Windows XP

Important  Install TeamBoard Suite before connecting the USB adapter

1) Insert the TeamBoard Suite DVD into your computer’s DVD drive.

2) Determine whether a computer is running a 32-bit version or 64-bit version of Windows.
   ▪ To determine which operating system version you have:
     a. Click Start
     b. Click Run . . .

Note  If you do not see Run. . . contact your system administrator.

c. Type msinfo32.exe in the Open field

   ![Run window with msinfo32.exe](image)

   *Run with msinfo32.exe*

d. Your operating system will appear as follows:
   i. If x64-based PC appears beside System Type you have a 64 bit version of Windows and should install setup64.exe

      System Type  x64-based PC

   ii. If X86-based PC appears beside System Type you have a 32 bit version of Windows and should install setup32.exe

      System Type  X86-based PC
3) Select and open the correct installer

*The Welcome screen displays.*

![TeamBoard Install](image)

This program will install TeamBoard drivers and Draw software on your computer.

Click “Instal” to proceed, or “Cancel” if you do not wish to install the software at the time.

---

4) On the Welcome screen verify your controller is supported. Then click install.

**Note:** If you are not sure which controller you have, check the label on the controller (located on the back of the TeamBoard). If you are unable to find the label or are still unsure contact Technical Support (page 2.)

*TeamBoard Suite installs.*

![Installing](image)
5) Once TeamBoard Suite has finished installing it will display the Install Successful screen. Click Close.

TeamBoard Suite has been installed successfully.

6) Restart your computer

7) Plug the USB adapter into a USB port on your computer.

**Important** You should now complete all calibrations (page 22.)
Chapter 3 - TeamBoard Menus

TeamBoard System Tray Menu

The TeamBoard System Tray menu is the easiest way to open TeamBoard features. It can be accessed by left or right clicking on the system tray icon.

![TeamBoard System Tray Menu on a Windows 7 system](image)

In the system tray you will see eight options.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>This selection is used to enable or disable a TeamBoard.</td>
<td></td>
</tr>
<tr>
<td>Calibrate</td>
<td>This selection is used to open the calibrate menu</td>
<td>22</td>
</tr>
<tr>
<td>Draw</td>
<td>This selection is used to open TeamBoard Draw</td>
<td>37</td>
</tr>
<tr>
<td>Annotate</td>
<td>This selection is used to open TeamBoard Draw in the Annotate mode</td>
<td>111</td>
</tr>
<tr>
<td>Virtual Keyboard</td>
<td>This button is used to open the virtual keyboard</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>This button will open the TeamBoard User Guide</td>
<td></td>
</tr>
<tr>
<td>About</td>
<td>This button will open the About menu</td>
<td></td>
</tr>
</tbody>
</table>
TeamBoard Start Menu Folder

Windows 8

The TeamBoard Start menu icons are shortcuts to various TeamBoard Suite applications. It can be accessed by opening the Start Menu.

In the Start Menu you will see three options.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Actionbar Editor" /></td>
<td>This button will open the ActionBar Editor</td>
<td>Page 119</td>
</tr>
<tr>
<td><img src="image" alt="Dashboard" /></td>
<td>This button will open TeamBoard Dashboard</td>
<td>Page 21</td>
</tr>
<tr>
<td><img src="image" alt="Draw" /></td>
<td>This button will open TeamBoard Draw</td>
<td>Page 37</td>
</tr>
</tbody>
</table>
Windows XP, Windows Vista, Windows 7

The TeamBoard Start menu folder is the location where TeamBoard Suite applications are stored (by default.) It can be accessed by opening the Start Menu, selecting the Programs or All Programs folder and clicking the TeamBoard folder.

![TeamBoard Start Menu folder on a Windows 7 system](image)

In the Start Menu you will see five options.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝 Actionbar Editor</td>
<td>This button will open the ActionBar Editor</td>
<td>119</td>
</tr>
<tr>
<td>🔖 Dashboard</td>
<td>This button will open TeamBoard Dashboard</td>
<td>21</td>
</tr>
<tr>
<td>✒️ Draw</td>
<td>This button will open TeamBoard Draw</td>
<td>37</td>
</tr>
<tr>
<td>📚 Help</td>
<td>This button will open the TeamBoard User Guide</td>
<td></td>
</tr>
<tr>
<td>🛥️ Virtual Keyboard</td>
<td>This button is used to open the virtual keyboard</td>
<td></td>
</tr>
</tbody>
</table>
**TeamBoard Dashboard**

The TeamBoard Dashboard is a quick and easy way to access important TeamBoard features and functions. It can be accessed by double clicking on the system tray icon or by selecting Dashboard from the TeamBoard folder in the start menu.

![TeamBoard Dashboard on a Windows System](image)

On the Dashboard you will see five buttons and a mode selector (depending on the model.)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calibrate Button</strong></td>
<td>This button is used to calibrate the TeamBoard</td>
<td>22</td>
</tr>
<tr>
<td><strong>TeamBoard Draw Button</strong></td>
<td>This button is used to open TeamBoard Draw</td>
<td>37</td>
</tr>
<tr>
<td><strong>Annotate Button</strong></td>
<td>This button is used to open TeamBoard Draw in Annotate Mode</td>
<td>111</td>
</tr>
<tr>
<td><strong>Virtual Keyboard Button</strong></td>
<td>This button is used to open the virtual keyboard</td>
<td></td>
</tr>
<tr>
<td><strong>Help Button</strong></td>
<td>This button will open the TeamBoard User Guide</td>
<td></td>
</tr>
</tbody>
</table>

**TeamBoard H-Series USB, TeamBoard 3 VRT only**

**TeamBoard Mode Selector**  This button will allow the you to change the TeamBoards mode
Chapter 4 – Calibration

About Calibration

Calibration is required to correctly associate the TeamBoard drawing surface with your computer environment.

If you have an H-Series USB TeamBoard or TeamBoard 3 VRT you need to perform Whiteboard and ActionBar calibrations. You should not need to perform these calibrations again.

Interactive calibration should be performed each time the projector or TeamBoard is moved, since the size and location of the image can change.

For information on Pressure calibration please see page 32.
Calibrating TeamBoard on Windows Systems

Whiteboard Calibration

*TeamBoard H-Series USB, TeamBoard 3 VRT*

1) On your computer, double-click the TeamBoard System Tray icon.

![TeamBoard System Tray icon on a Windows 7 system](image)

The TeamBoard Dashboard displays.

![TeamBoard Dashboard](image)

2) Select the **Calibrate** button.

![Calibrate button](image)

The Calibration selection window displays.
3) Select the **Whiteboard** radio button.

![Calibration selection window with a TeamBoard 3 VRT connected](image)

*The Whiteboard calibration window opens.*

4) Firmly press the top-left corner of the TeamBoard drawing surface.

**Important** At the TeamBoard, if your projector is on, DO NOT touch the projected arrow tips or circles in the reference photo.

**Note** If the TeamBoard does not receive a response within 15 seconds the calibration screen will automatically close. Repeat steps 1-3 to re-attempt calibration.

![Calibration screen asking to calibrate the top-left corner of the drawing surface](image)

**Note** If sound is enabled on your computer, you will hear a 'ping' and the next screen displays.
5) Press the bottom-right corner of the TeamBoard drawing surface.

Calibration screen asking to calibrate the bottom-right corner of the drawing surface

*Note* If sound is enabled on your computer, you will hear a 'ping'

*The Calibration window closes. Whiteboard Calibration is now completed successfully.*

*Tip* You can also access Whiteboard calibration from the System Tray menu.
ActionBar Calibration

TeamBoard H-Series USB, TeamBoard 3 VRT

1) On your computer, double-click the TeamBoard System Tray icon.

The TeamBoard System Tray icon on a Windows 7 System

The TeamBoard Dashboard displays.

2) Select the Calibrate button.

The Calibration selection window displays.

3) Select the ActionBar radio button.
The ActionBar calibration window opens.

4) Firmly press the top-left corner of the TeamBoard ActionBar.

**Important** At the TeamBoard, if your projector is on, DO NOT touch the projected arrow tips or circles in the reference photo.

**Note** If the TeamBoard does not receive a response within 15 seconds the calibration screen will automatically close. Repeat steps 1-3 to re-attempt calibration.

*Calibration screen asking to calibrate the top-left corner of the ActionBar*

**Note** If sound is enabled on your computer, you will hear a 'ping' and the next screen displays.
5) Firmly press the top-right corner of the TeamBoard ActionBar.

*Calibration screen asking to calibrate the top-right corner of the ActionBar*

**Note** If sound is enabled on your computer, you will hear a 'ping'

*The Calibration window closes. ActionBar Calibration is now completed successfully.*

**Tip** You can also access ActionBar calibration from the System Tray menu.
Interactive Calibration

*TeamBoard H-Series USB, TeamBoard 3 VRT, TeamBoard IR, TeamBoard Touch Monitor*

**Important** Before you perform Interactive calibration for the first time you must perform Whiteboard and ActionBar calibrations (TeamBoard H-Series USB and TeamBoard 3 VRT only.)

**Important** A projector must be on and directed at the TeamBoard to perform Interactive calibration.

1) On your computer, double-click the TeamBoard System Tray icon.

![TeamBoard System Tray icon on a Windows 7 System](image)

The TeamBoard Dashboard displays.

![TeamBoard Dashboard](image)

**Note** Mode will not appear if a TeamBoard IR or TeamBoard Touch Monitor is connected.

2) Select the **Calibrate** button.

![Calibrate button](image)

The Calibration dialog box displays.
3) Select the **Interactive** radio button.

![Calibration selection window with a TeamBoard 3 VRT connected](image)

4) A message will appear asking you to ensure that the projected image is correctly keystoned and within the TeamBoard frame.

**Information**  Keystoneing occurs when your projector has not been positioned at the correct height or angle to the screen. Most data projectors have ‘keystone correction’ feature to resolve this problem (refer to your data projector’s User Guide for instructions.)

![Keystone verification window](image)

5) Once you have verified the projected image is keystoned correctly and within the frame click **OK**.

*The Interactive calibration window opens.*
6) On the Interactive calibration window touch all nine points where the lines cross.

**Important** Ensure that you touch the point where the lines cross precisely, as this ensures the TeamBoard is accurately calibrated. As each point is touched, a green check mark will display.

**Note** If the TeamBoard does not receive a response within 15 seconds the calibration screen will automatically close. Repeat steps 1-5 to re-attempt calibration.

**Note** If sound is enabled on your computer, you will hear a 'ping' after each successful calibration point.

*Interactive calibration screen*

*The Calibration window closes. Interactive Calibration is now completed successfully.*

**Tip** You can also access Interactive calibration from the System Tray menu.
Pressure Calibration

TeamBoard 3 VRT

Important Before you perform pressure calibration for the first time you must perform Whiteboard, ActionBar, and Interactive calibrations.

Important A projector must be on and directed at the TeamBoard to perform Pressure calibration.

1) On your computer, double-click the TeamBoard System Tray icon.

![TeamBoard System Tray icon on a Windows 7 System](image)

*The TeamBoard Dashboard displays.*

![TeamBoard Dashboard](image)

2) Select the **Calibrate** button.

![Calibrate button](image)

*The Calibration dialog box displays.*
3) Select the **Pressure** radio button.

![Calibration selection window with a TeamBoard 3 VRT connected](image)

*The Pressure calibration window opens.*

4) Press on the blue spot **lightly** and hold your finger on that point as the traffic light turns yellow and then green.

![Light calibration start window](image)

*Light calibration start window*
5) Release your finger from the board.

*Light pressure calibration is complete. The Firm pressure calibration window opens.*
6) Press on the blue spot **firmly** and hold your finger on that point as the traffic light turns yellow and then green.

![Firm calibration start window](image)

*Firm calibration start window*
7) Release your finger from the board.

*Firm pressure and Pressure calibration is complete*

**Tip** You can also access Pressure calibration from the System Tray menu.
Chapter 5 – TeamBoard Draw Interface

Opening TeamBoard Draw

1) On your computer, double-click the TeamBoard System Tray icon.

![TeamBoard System Tray icon on a Windows 7 system]

*The TeamBoard Dashboard displays.*

![TeamBoard Dashboard]

2) Press the Draw button

![Draw button]

*TeamBoard Draw opens.*
**Note** If this is your first time opening Draw you will be asked to register. Registering will give you access to the latest software as well as other benefits.

***TeamBoard Draw registration window***

**Tip** TeamBoard Draw can also be opened from the Start Menu and System Tray.
# TeamBoard Draw Interface for TeamBoard H-Series USB, TeamBoard IR, and TeamBoard Touch Monitor

## Toolbars

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Toolbar</strong></td>
<td>40</td>
</tr>
<tr>
<td><strong>Drawing Toolbar</strong></td>
<td>41</td>
</tr>
<tr>
<td><strong>Custom Toolbar</strong></td>
<td>41</td>
</tr>
<tr>
<td><strong>ActionBar</strong></td>
<td>58</td>
</tr>
<tr>
<td><strong>Annotate</strong></td>
<td>111</td>
</tr>
<tr>
<td><strong>Page Sorter</strong></td>
<td>78</td>
</tr>
</tbody>
</table>
On the Standard toolbar you will see 15 options.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>New Workbook</td>
<td>Create a new Draw Workbook</td>
</tr>
<tr>
<td>☐</td>
<td>Open File</td>
<td>Open an existing TeamBoard Draw workbook</td>
</tr>
<tr>
<td>☐</td>
<td>Save File</td>
<td>Save a TeamBoard Draw workbook</td>
</tr>
<tr>
<td>☐</td>
<td>Print Current Page</td>
<td>Prints the current page</td>
</tr>
<tr>
<td>☐</td>
<td>Print Preview</td>
<td>Presents a preview of what pages will look like when printed</td>
</tr>
<tr>
<td>☐</td>
<td>Undo</td>
<td>Erases the last change done to the Workbook</td>
</tr>
<tr>
<td>☐</td>
<td>Redo</td>
<td>Undoes the last Undo action</td>
</tr>
<tr>
<td>☐</td>
<td>Full-Screen Mode</td>
<td>Places TeamBoard in the full screen mode</td>
</tr>
<tr>
<td>☐</td>
<td>ClipArt Viewer</td>
<td>Shows the available clipart</td>
</tr>
<tr>
<td>☐</td>
<td>Record with Sound</td>
<td>Starts a recording</td>
</tr>
<tr>
<td>☐</td>
<td>Stop Recording</td>
<td>Stops a recording</td>
</tr>
<tr>
<td>☐</td>
<td>Playback a TeamBoard Recording</td>
<td>Plays back a recording, including sound</td>
</tr>
<tr>
<td>☐</td>
<td>Help</td>
<td>This button will open the TeamBoard User Guide</td>
</tr>
<tr>
<td>☐</td>
<td>Draw Tutorials</td>
<td>Explains how to complete common TeamBoard Draw tasks</td>
</tr>
</tbody>
</table>
Custom Toolbar

On the Custom Toolbar you will see one option (by default.)

Website Link | Provides a quick link to the TeamBoard website

Drawing Toolbar

On the Drawing Toolbar you will see 10 options.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pen Tool</td>
<td>42</td>
</tr>
<tr>
<td>Eraser Tool</td>
<td>43</td>
</tr>
<tr>
<td>Shape Tool</td>
<td>44</td>
</tr>
<tr>
<td>Creative Pen Tool</td>
<td>45</td>
</tr>
<tr>
<td>Text Tool</td>
<td>46</td>
</tr>
<tr>
<td>Move Tool</td>
<td>46</td>
</tr>
<tr>
<td>Clipboard Tool</td>
<td>47</td>
</tr>
<tr>
<td>Hide/ Reveal</td>
<td>103</td>
</tr>
<tr>
<td>Protractor</td>
<td>98</td>
</tr>
<tr>
<td>Spotlight</td>
<td></td>
</tr>
</tbody>
</table>
Pen Toolbar

Pen Tool Button

TeamBoard Draw Drawing Toolbar with Pen Toolbar Selected

On the Pen Toolbar you will see 15 options for you to select. For information on using these pens see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Line</td>
<td>Draws a solid line</td>
</tr>
<tr>
<td>Dashed Line</td>
<td>Draws a dashed line</td>
</tr>
<tr>
<td>Highlighter</td>
<td>Draws semi-opaque coloured line</td>
</tr>
<tr>
<td>Line</td>
<td>Creates a straight line</td>
</tr>
<tr>
<td>Free Form</td>
<td>Creates a straight line from point to point</td>
</tr>
<tr>
<td>Arrow</td>
<td>Creates an arrow</td>
</tr>
<tr>
<td>Bi-Directional Arrow</td>
<td>Creates a bi-directional arrow</td>
</tr>
<tr>
<td>Arrow Style 3</td>
<td>Creates an anchored arrow</td>
</tr>
<tr>
<td>Arrow Style 4</td>
<td>Creates a dashed anchored arrow</td>
</tr>
<tr>
<td>Arrow Style 5</td>
<td>Creates a dashed arrow</td>
</tr>
<tr>
<td>Arrow Style 6</td>
<td>Creates a dashed bi-directional arrow</td>
</tr>
<tr>
<td>Variable Width Arrow</td>
<td>Draws a variable width arrow</td>
</tr>
<tr>
<td>Width Selector</td>
<td></td>
</tr>
<tr>
<td>Colour Selector</td>
<td></td>
</tr>
<tr>
<td>Custom Colour Selector</td>
<td></td>
</tr>
</tbody>
</table>
Eraser Toolbar

On the Eraser Toolbar you will see two options for you to select. For information on using these erasers see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Eraser</td>
<td>Erases a small amount of data</td>
</tr>
<tr>
<td>Large Eraser</td>
<td>Remove items as you click on them or allows you to delete multiple items</td>
</tr>
</tbody>
</table>
**Shape Toolbar**

*Shape Tool Button*

![TeamBoard Draw Drawing Toolbar with Shape Toolbar Selected](image)

On the Shape Toolbar you will see 20 options. For information on using these shapes see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Shape Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellipse</td>
<td>Creates an ellipse</td>
</tr>
<tr>
<td>Perfect Circle</td>
<td>Creates a perfect circle</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Creates a rectangle</td>
</tr>
<tr>
<td>Square</td>
<td>Creates a square</td>
</tr>
<tr>
<td>Triangle</td>
<td>Creates a triangle</td>
</tr>
<tr>
<td>Right Triangle</td>
<td>Creates a right angle triangle</td>
</tr>
<tr>
<td>Pentagon</td>
<td>Creates a pentagon</td>
</tr>
<tr>
<td>Polygon</td>
<td>Allows you to create a polygon with 3 to 10 sides</td>
</tr>
<tr>
<td>Filled Ellipse</td>
<td>Creates a filled ellipse</td>
</tr>
<tr>
<td>Filled Perfect Circle</td>
<td>Creates a filled perfect circle</td>
</tr>
<tr>
<td>Filled Rectangle</td>
<td>Creates a filled rectangle</td>
</tr>
<tr>
<td>Filled Square</td>
<td>Creates a filled square</td>
</tr>
<tr>
<td>Filled Triangle</td>
<td>Creates a filled triangle</td>
</tr>
<tr>
<td>Filled Right Triangle</td>
<td>Creates a filled right angle triangle</td>
</tr>
<tr>
<td>Filled Pentagon</td>
<td>Creates a filled pentagon</td>
</tr>
<tr>
<td>Width Selector</td>
<td></td>
</tr>
<tr>
<td>Colour Selector</td>
<td></td>
</tr>
<tr>
<td>Custom Colour Selector</td>
<td></td>
</tr>
</tbody>
</table>
**Creative Pen Toolbar**

On the Creative Pen Toolbar you will see 15 options. For information on using these pens see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Pen</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rhombus</td>
<td>Draws a line of Rhombuses</td>
</tr>
<tr>
<td>Circle</td>
<td>Draws a line of circles</td>
</tr>
<tr>
<td>Star and Circle</td>
<td>Draws a line of stars and circles</td>
</tr>
<tr>
<td>Zigzag</td>
<td>Draws a zigzag line</td>
</tr>
<tr>
<td>Rainbow1</td>
<td>Draws a multi-coloured line</td>
</tr>
<tr>
<td>Rainbow2</td>
<td>Draws a different multi-coloured line</td>
</tr>
<tr>
<td>Road Style</td>
<td>Draws a line that looks like a road</td>
</tr>
<tr>
<td>Railway Track Style</td>
<td>Draws a line that looks like railway tracks</td>
</tr>
<tr>
<td>Text to go along path style</td>
<td>Draws a customizable text banner</td>
</tr>
<tr>
<td>Custom Pen</td>
<td>Creates a pen filled with shapes as setup by you</td>
</tr>
<tr>
<td>Width Selector</td>
<td></td>
</tr>
<tr>
<td>Colour Selector</td>
<td></td>
</tr>
<tr>
<td>Custom Colour Selector</td>
<td></td>
</tr>
</tbody>
</table>
**Text Toolbar**

[Image: Text Tool Button]

On the Text Toolbar you will see six options. For information on using these tools see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Tool</td>
<td>Allows you to enter text in the current page</td>
</tr>
<tr>
<td>Word Selection</td>
<td>Allows you to highlight individual words.</td>
</tr>
<tr>
<td>Word Bank</td>
<td>Opens the word bank list.</td>
</tr>
<tr>
<td>Speak Individual Words</td>
<td>Click a word and hear it spoken.</td>
</tr>
<tr>
<td>Speak Sentences</td>
<td>Click a sentence and hear it spoken.</td>
</tr>
<tr>
<td>Virtual Keyboard</td>
<td>This button is used to open the virtual keyboard.</td>
</tr>
</tbody>
</table>

**Move Toolbar**

[Image: Move Tool Button]

On the Creative Pen Toolbar you will see three options. For information on using these tools see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object-Move</td>
<td>Allows you to manipulate objects.</td>
</tr>
<tr>
<td>Link the Selected Object</td>
<td>Opens the Links dialog box.</td>
</tr>
<tr>
<td>Fill Colour to Selected Shape</td>
<td>Fills a shape, object or background with a colour.</td>
</tr>
</tbody>
</table>
**Clipboard Toolbar**

On the Clipboard Toolbar you will see five options. For information on using these tools see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Multi-Copy</strong></td>
<td>Adds a copy of multiple objects on the clipboard</td>
</tr>
<tr>
<td><strong>Object-Copy</strong></td>
<td>Adds a copy of the selected object on the clipboard</td>
</tr>
<tr>
<td><strong>Multi-Cut</strong></td>
<td>Removes multiple objects from the page and places them on the clipboard</td>
</tr>
<tr>
<td><strong>Object-Cut</strong></td>
<td>Removes the selected object from the page and places it on the clipboard</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Pastes the contents of the clipboard onto the page</td>
</tr>
</tbody>
</table>
# TeamBoard 3 VRT Draw Interface

## Toolbars

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Toolbar</td>
<td>49</td>
</tr>
<tr>
<td>Drawing Toolbar</td>
<td>50</td>
</tr>
<tr>
<td>Dual Toolbar</td>
<td>51</td>
</tr>
<tr>
<td>Custom Toolbar</td>
<td>50</td>
</tr>
<tr>
<td>ActionBar</td>
<td>58</td>
</tr>
<tr>
<td>Annotate</td>
<td>111</td>
</tr>
<tr>
<td>Page Sorter</td>
<td>78</td>
</tr>
</tbody>
</table>
### Standard Toolbar

**TeamBoard Draw Standard Toolbar**

On the Standard toolbar you will see 15 options.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📄</td>
<td>New Workbook</td>
<td>Create a new Draw Workbook</td>
</tr>
<tr>
<td>📂</td>
<td>Open File</td>
<td>Open an existing TeamBoard Draw workbook</td>
</tr>
<tr>
<td>📃</td>
<td>Save File</td>
<td>Save a TeamBoard Draw workbook</td>
</tr>
<tr>
<td>📹</td>
<td>Print Current Page</td>
<td>Prints the current page</td>
</tr>
<tr>
<td>📹</td>
<td>Print Preview</td>
<td>Presents a preview of what pages will look like when printed</td>
</tr>
<tr>
<td>🔄</td>
<td>Undo</td>
<td>Erases the last change done to the Workbook</td>
</tr>
<tr>
<td>🔄</td>
<td>Redo</td>
<td>Undoes the last Undo action</td>
</tr>
<tr>
<td>🎬</td>
<td>Full-Screen Mode</td>
<td>Places TeamBoard in the full screen mode</td>
</tr>
<tr>
<td>🎬</td>
<td>ClipArt Viewer</td>
<td>Shows the available clipart</td>
</tr>
<tr>
<td>🔴</td>
<td>Record with Sound</td>
<td>Starts a recording</td>
</tr>
<tr>
<td>🔴</td>
<td>Stop Recording</td>
<td>Stops a recording</td>
</tr>
<tr>
<td>🔴</td>
<td>Playback a TeamBoard Recording</td>
<td>Plays back a recording, including sound</td>
</tr>
<tr>
<td>❓</td>
<td>Help</td>
<td>This button will open the TeamBoard User Guide</td>
</tr>
<tr>
<td>❓</td>
<td>Draw Tutorials</td>
<td>Explains how to complete common TeamBoard Draw tasks</td>
</tr>
</tbody>
</table>
Custom Toolbar

**TeamBoard Draw Custom Toolbar**

On the Custom Toolbar you will see one option (by default.)

| Website Link | Provides a quick link to the TeamBoard website |

Drawing Toolbar

**TeamBoard Draw Drawing Toolbar**

On the Drawing Toolbar you will see 10 options.

| Pen Tools | Page 52 |
| Eraser Tools | Page 53 |
| Shape Tools | Page 54 |
| Creative Pen Tools | Page 55 |
| Text Tools | Page 56 |
| Move Tool | Page 56 |
| Clipboard Tool | Page 57 |
| Hide/Reveal | Page 103 |
| Protractor | |
| Spotlight | Page 98 |
| **Switch Toolbar** | Switch between Drawing and Dual Toolbar |
## Dual Toolbar

**TeamBoard Draw Dual Toolbar**

<table>
<thead>
<tr>
<th>Drawing Toolbar Item</th>
<th>Drawing Toolbar Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specific Toolbar</td>
<td></td>
</tr>
<tr>
<td>Width Selector</td>
<td></td>
</tr>
<tr>
<td>Colour Selector</td>
<td></td>
</tr>
<tr>
<td>3D Use Variable Pressure</td>
<td>Use variable pressure with the selected item</td>
</tr>
<tr>
<td>Reveal/Hide</td>
<td></td>
</tr>
<tr>
<td>Protractor</td>
<td></td>
</tr>
<tr>
<td>Spotlight</td>
<td></td>
</tr>
<tr>
<td>3D Switch Toolbar Position</td>
<td>Switches the dual toolbar to the lower position</td>
</tr>
<tr>
<td>Switch Toolbar</td>
<td>Allows you to switch between Drawing and Dual Toolbar</td>
</tr>
</tbody>
</table>
Pen Toolbar

On the Pen Toolbar you will see 15 options for you to select. For information on using these pens see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Line</td>
<td>Draws a solid line</td>
</tr>
<tr>
<td>Dashed Line</td>
<td>Draws a dashed line</td>
</tr>
<tr>
<td>Highlighter</td>
<td>Draws semi-opaque coloured line</td>
</tr>
<tr>
<td>Line</td>
<td>Creates a straight line</td>
</tr>
<tr>
<td>Free Form</td>
<td>Creates a straight line from point to point</td>
</tr>
<tr>
<td>Arrow</td>
<td>Creates an arrow</td>
</tr>
<tr>
<td>Bi-Directional Arrow</td>
<td>Creates a bi-directional arrow</td>
</tr>
<tr>
<td>Arrow Style 3</td>
<td>Creates an anchored arrow</td>
</tr>
<tr>
<td>Arrow Style 4</td>
<td>Creates a dashed anchored arrow</td>
</tr>
<tr>
<td>Arrow Style 5</td>
<td>Creates a dashed arrow</td>
</tr>
<tr>
<td>Arrow Style 6</td>
<td>Creates a dashed bi-directional arrow</td>
</tr>
<tr>
<td>Variable Width Arrow</td>
<td>Draws a variable width arrow</td>
</tr>
<tr>
<td>Width Selector</td>
<td></td>
</tr>
<tr>
<td>Colour Selector</td>
<td></td>
</tr>
<tr>
<td>Custom Colour Selector</td>
<td></td>
</tr>
</tbody>
</table>
On the Eraser Toolbar you will see two options for you to select. For information on using these erasers see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th></th>
<th>Erases a small amount of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Eraser</td>
<td></td>
</tr>
<tr>
<td>Large Eraser</td>
<td>Remove items as you click on them or allows you to delete multiple</td>
</tr>
<tr>
<td></td>
<td>items</td>
</tr>
</tbody>
</table>
Shape Toolbar

Shape Tool Button

TeamBoard Draw Drawing Toolbar with Shape Toolbar Selected

On the Shape Toolbar you will see 20 options. For information on using these shapes see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Shape</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellipse</td>
<td>Creates an ellipse</td>
</tr>
<tr>
<td>Perfect Circle</td>
<td>Creates a perfect circle</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Creates a rectangle</td>
</tr>
<tr>
<td>Square</td>
<td>Creates a square</td>
</tr>
<tr>
<td>Triangle</td>
<td>Creates a triangle</td>
</tr>
<tr>
<td>Right Triangle</td>
<td>Creates a right angle triangle</td>
</tr>
<tr>
<td>Pentagon</td>
<td>Creates a pentagon</td>
</tr>
<tr>
<td>Polygon</td>
<td>Allows you to create a polygon with 3 to 10 sides</td>
</tr>
<tr>
<td>Filled Ellipse</td>
<td>Creates a filled ellipse</td>
</tr>
<tr>
<td>Filled Perfect Circle</td>
<td>Creates a filled perfect circle</td>
</tr>
<tr>
<td>Filled Rectangle</td>
<td>Creates a filled rectangle</td>
</tr>
<tr>
<td>Filled Square</td>
<td>Creates a filled square</td>
</tr>
<tr>
<td>Filled Triangle</td>
<td>Creates a filled triangle</td>
</tr>
<tr>
<td>Filled Right Triangle</td>
<td>Creates a filled right angle triangle</td>
</tr>
<tr>
<td>Filled Pentagon</td>
<td>Creates a filled pentagon</td>
</tr>
<tr>
<td>Width Selector</td>
<td></td>
</tr>
<tr>
<td>Colour Selector</td>
<td></td>
</tr>
<tr>
<td>Custom Colour Selector</td>
<td></td>
</tr>
</tbody>
</table>
**Creative Pen Toolbar**

![Creative Pen Tool Button](Image)

On the Creative Pen Toolbar you will see 15 options. For information on using these pens see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Pen</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rhombus</td>
<td>Draws a line of Rhombuses</td>
</tr>
<tr>
<td>Circle</td>
<td>Draws a line of circles</td>
</tr>
<tr>
<td>Star and Circle</td>
<td>Draws a line of stars and circles</td>
</tr>
<tr>
<td>Zigzag</td>
<td>Draws a zigzag line</td>
</tr>
<tr>
<td>Rainbow1</td>
<td>Draws a multi-coloured line</td>
</tr>
<tr>
<td>Rainbow2</td>
<td>Draws a different multi-coloured line</td>
</tr>
<tr>
<td>Road Style</td>
<td>Draws a line that looks like a road</td>
</tr>
<tr>
<td>Railway Track Style</td>
<td>Draws a line that looks like railway tracks</td>
</tr>
<tr>
<td>Text to go along path style</td>
<td>Draws a customizable text banner</td>
</tr>
<tr>
<td>Custom Pen</td>
<td>Creates a pen filled with shapes as setup by you</td>
</tr>
<tr>
<td>Width Selector</td>
<td></td>
</tr>
<tr>
<td>Colour Selector</td>
<td></td>
</tr>
<tr>
<td>Custom Colour Selector</td>
<td></td>
</tr>
</tbody>
</table>
Text Toolbar

![Text Tool Button](Image)

TeamBoard Draw Drawing Toolbar with Text Toolbar Selected

On the Text Toolbar you will see six options. For information on using these tools see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>-tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Tool</td>
<td>Allows you to enter text in the current page</td>
</tr>
<tr>
<td>Word Selection</td>
<td>Allows you to highlight individual words.</td>
</tr>
<tr>
<td>Word Bank</td>
<td>Opens the word bank list.</td>
</tr>
<tr>
<td>Speak Individual Words</td>
<td>Click a word and hear it spoken</td>
</tr>
<tr>
<td>Speak Sentences</td>
<td>Click a sentence and hear it spoken.</td>
</tr>
<tr>
<td>Virtual Keyboard</td>
<td>This button is used to open the virtual keyboard</td>
</tr>
</tbody>
</table>

Move Toolbar

![Move Tool Button](Image)

TeamBoard Draw Drawing Toolbar with Move Toolbar Selected

On the Creative Pen Toolbar you will see three options. For information on using these tools see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>-tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object-Move</td>
<td>Allows you to manipulate objects.</td>
</tr>
<tr>
<td>Link the Selected Object</td>
<td>Opens the Links dialog box.</td>
</tr>
<tr>
<td>Fill Colour to Selected Shape</td>
<td>Fills a shape, object or background with a colour</td>
</tr>
</tbody>
</table>
On the Clipboard Toolbar you will see five options. For information on using these tools see Chapter 8 (page 65.)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Copy</td>
<td>Adds a copy of multiple objects on the clipboard</td>
</tr>
<tr>
<td>Object-Copy</td>
<td>Adds a copy of the selected object on the clipboard</td>
</tr>
<tr>
<td>Multi-Cut</td>
<td>Removes multiple objects from the page and places them on the clipboard</td>
</tr>
<tr>
<td>Object-Cut</td>
<td>Removes the selected object from the page and places it on the clipboard</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the contents of the clipboard onto the page</td>
</tr>
</tbody>
</table>
Chapter 6 – TeamBoard ActionBar

TeamBoard H-Series USB, TeamBoard 3 VRT

ActionBar Explained

The TeamBoard ActionBar is a series of buttons located on the bottom of the TeamBoard. They offer quick and easy access to numerous common functions and allow you to control TeamBoard Draw as well as other applications from the TeamBoard.

TeamBoard H-Series USB

The TeamBoard H-Series USB has 15 buttons that allow you to complete common task right from the board.

TeamBoard ActionBar on an H-Series USB

TeamBoard 3 VRT

With the TeamBoard 3 VRT you get 4 additional buttons on the ActionBar. These additional buttons can be programmed to do anything, in any application, allowing you to easily run common commands, open frequent programs, or anything else you wish, all from the TeamBoard. 

For more information on programming the ActionBar see page 119.

TeamBoard ActionBar on a TeamBoard 3 VRT
**ActionBar in Whiteboard Mode**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Small Eraser" /></td>
<td>Selects the small eraser</td>
</tr>
<tr>
<td><img src="image" alt="Large Eraser" /></td>
<td>Selects the large eraser</td>
</tr>
<tr>
<td><img src="image" alt="Black Pen" /></td>
<td>Selects the Solid Line Pen Tool in the black colour</td>
</tr>
<tr>
<td><img src="image" alt="Red Pen" /></td>
<td>Selects the Solid Line Pen Tool in the red colour</td>
</tr>
<tr>
<td><img src="image" alt="Brown Pen" /></td>
<td>Selects the Solid Line Pen Tool in the brown colour</td>
</tr>
<tr>
<td><img src="image" alt="Green Pen" /></td>
<td>Selects the Solid Line Pen Tool in the green colour</td>
</tr>
<tr>
<td><img src="image" alt="Purple Pen" /></td>
<td>Selects the Solid Line Pen Tool in the purple colour</td>
</tr>
<tr>
<td><img src="image" alt="Blue Pen" /></td>
<td>Selects the Solid Line Pen Tool in the blue colour</td>
</tr>
<tr>
<td><img src="image" alt="New Page" /></td>
<td>Inserts a new page in TeamBoard Draw</td>
</tr>
<tr>
<td><img src="image" alt="Copy Page" /></td>
<td>Copies the current page and places it on a new page</td>
</tr>
<tr>
<td><img src="image" alt="Print Page" /></td>
<td>Prints the TeamBoard Draw workbook using the default printer</td>
</tr>
<tr>
<td><img src="image" alt="Rewind" /></td>
<td>Switches to the first page</td>
</tr>
<tr>
<td><img src="image" alt="Reverse" /></td>
<td>Moves back one page</td>
</tr>
<tr>
<td><img src="image" alt="Forward" /></td>
<td>Moves forward one page</td>
</tr>
<tr>
<td><img src="image" alt="Fast Forward" /></td>
<td>Switches to the last page</td>
</tr>
<tr>
<td><img src="image" alt="Customizable" /></td>
<td>These buttons do nothing by default</td>
</tr>
</tbody>
</table>

*TeamBoard 3 VRT only*
## Interactive Mode in TeamBoard Draw

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Small Eraser" /></td>
<td>Selects the small eraser</td>
</tr>
<tr>
<td><img src="image" alt="Large Eraser" /></td>
<td>Selects the large eraser</td>
</tr>
<tr>
<td><img src="image" alt="Black Pen" /></td>
<td>Selects the Solid Line Pen Tool in the black colour</td>
</tr>
<tr>
<td><img src="image" alt="Red Pen" /></td>
<td>Selects the Solid Line Pen Tool in the red colour</td>
</tr>
<tr>
<td><img src="image" alt="Brown Pen" /></td>
<td>Selects the Solid Line Pen Tool in the brown colour</td>
</tr>
<tr>
<td><img src="image" alt="Green Pen" /></td>
<td>Selects the Solid Line Pen Tool in the green colour</td>
</tr>
<tr>
<td><img src="image" alt="Purple Pen" /></td>
<td>Selects the Solid Line Pen Tool in the purple colour</td>
</tr>
<tr>
<td><img src="image" alt="Blue Pen" /></td>
<td>Selects the Solid Line Pen Tool in the blue colour</td>
</tr>
<tr>
<td><img src="image" alt="New Page" /></td>
<td>Inserts a new page in TeamBoard Draw</td>
</tr>
<tr>
<td><img src="image" alt="Copy Page" /></td>
<td>Copies the current page and places it on a new page</td>
</tr>
<tr>
<td><img src="image" alt="Print Page" /></td>
<td>Prints the TeamBoard Draw workbook</td>
</tr>
<tr>
<td><img src="image" alt="Rewind" /></td>
<td>Switches to the first page</td>
</tr>
<tr>
<td><img src="image" alt="Reverse" /></td>
<td>Moves back one page</td>
</tr>
<tr>
<td><img src="image" alt="Forward" /></td>
<td>Moves forward one page</td>
</tr>
<tr>
<td><img src="image" alt="Fast Forward" /></td>
<td>Switches to the last page</td>
</tr>
<tr>
<td><img src="image" alt="Customizable 1" /></td>
<td>Opens Teamboard.com (TeamBoard 3 VRT only, By default)</td>
</tr>
<tr>
<td><img src="image" alt="Customizable 2" /></td>
<td>Opens ActionBar Editor (TeamBoard 3 VRT only, By default)</td>
</tr>
<tr>
<td><img src="image" alt="Customizable 3" /></td>
<td>Opens TeamBoard 3 Benefits Sheet (TeamBoard 3 VRT only, By default)</td>
</tr>
<tr>
<td><img src="image" alt="Customizable 4" /></td>
<td>This button will open the TeamBoard User (TeamBoard 3 VRT only, By default)</td>
</tr>
</tbody>
</table>
Chapter 7 – Using TeamBoard Draw with a TeamBoard

Using TeamBoard Draw and a TeamBoard without a Projector

TeamBoard H-Series USB, TeamBoard 3 VRT

To use your TeamBoard without a projector you must use Whiteboard mode. Whiteboard mode allows you to write and draw on the TeamBoard with dry-erase markers and capture all of your work into TeamBoard Draw. You can also erase, print, create new pages and copy pages all from the TeamBoard. You can use your monitor and mouse to access further TeamBoard Draw features, such as saving, rearranging, deleting or adding to pages as well as emailing workbooks.

**Important**  
Dry erase markers containing alcohol based inks do not clean well from the TeamBoard.

Switching to Whiteboard Mode

1) On your computer, double-click the TeamBoard System Tray icon.

![TeamBoard System Tray icon on a Windows 7 System](image)

The TeamBoard Dashboard displays.

![TeamBoard Dashboard](image)
2) In the mode section select the Whiteboard button.

Tip If Whiteboard mode is already selected the board is in Whiteboard mode and does not need to be changed.

The TeamBoard is in Whiteboard mode.

Drawing and Writing on the TeamBoard

1) Ensure that your computer is turned on, and (if applicable,) that your projector is turned off.

Tip Ensure that your computer monitor is turned on when you work with TeamBoard Draw in Whiteboard mode. This allows you to see what you’re drawing. Since you can see the content on the monitor, you can ensure that the content you see on the TeamBoard is the same as the content on the computer.

2) Complete Whiteboard and ActionBar calibration (page 22.)

3) Touch the TeamBoard. TeamBoard Draw will automatically open.

4) Press a pen button on the TeamBoard’s ActionBar in the colour you want to use.

Red Pen

5) Using an Egan Marker or Whiteboard marker, preferably of the same colour as the virtual pen colour, write and draw on the TeamBoard.

Your computer monitor displays your work in the colour you have chosen.

Tip To write and draw using another colour, repeat steps 4 and 5
Erasing Drawings and Writing

To erase drawings and writing from both the TeamBoard and TeamBoard Draw, you have two options.
- **Small Eraser** to wipe off small parts of a drawing such as letters or numbers.
- **Large Eraser** to wipe off large areas.

**Using the Small Eraser**

1) Select the Small Erase Button on the ActionBar

![Small Eraser]

2) Erase drawings on the TeamBoard with the corner of an Egan Cloth or with your finger.

*The area is erased from both the TeamBoard and TeamBoard Draw*

**Using the Large Eraser**

1) Select the Large Eraser button on the ActionBar

![Large Eraser]

2) Erase drawings on the TeamBoard with an Egan Cloth.

*The area is erased from both the TeamBoard and TeamBoard Draw*

**Inserting a New Page**

1) Select the New Page button on the ActionBar

![New Page]

*TeamBoard Draw inserts a new page and switches to the Small Eraser*

**Other Functionality in Whiteboard Mode**

For more information on using other TeamBoard Draw features see Chapter 8 (page 65.)
Using TeamBoard Draw and a TeamBoard with a Projector

To use your TeamBoard with a projector you must use Interactive mode. Interactive mode allows you to access all the features and functions of TeamBoard Draw.

To see what functions you can perform with TeamBoard Draw see Chapter 8 (page 65.)

Switching to Interactive Mode

1) On your computer, double-click the TeamBoard System Tray icon. TeamBoard System Tray icon on a Windows 7 System

TeamBoard Dashboard displays.

2) In the mode section select the Interactive button. Tip If Interactive mode is already selected, the board is in Interactive mode and does not need to be changed.

The TeamBoard is in Interactive mode.
Chapter 8 – Essential TeamBoard Draw Functions

Drawing Stuff

Using Pens

1) Select the Pen Options icon from the Drawing Toolbar

**Note**  
Draw remembers the last selected Pen Option.

The Drawing Toolbar displays the pen options.

2) Select the desired pen type.

- To draw a solid line.

- To draw a dashed line.

- To draw a transparent line overtop other content, select the Highlighter

3) Select the desired pen width by clicking on the pen width arrow and select a size from the drop-down list.

**Note**  
Draw remembers the last selected width and highlighter pen width.
4) Select the desired pen colour.

5) Draw in the drawing area. TeamBoard Draw draws the line as you create it.

**Using Arrows**

1) Select the Pen Options icon from the Drawing Toolbar

**Note** Draw remembers the last selected Pen Option.

**Pen Options**

2) Select the desired arrow type.

- To draw an arrow.

- To draw a bi-directional arrow.

- To draw an anchored arrow.

- To draw a dashed anchored arrow.

- To draw a dashed arrow.
• To draw a dashed bi-directional arrow.

![Bi-Directional Arrow](image)

3) Select the desired pen width by clicking on the pen width arrow and select a size from the drop-down list.

**Note**  Draw remembers the last selected width and highlighter pen width

![Arrow Width selector](image)

4) Select the desired arrow colour.

5) Draw the arrow in the drawing area. TeamBoard Draw will preview the arrow and draw it when you are done.
Drawing Shapes

1) Select the Shape Options icon on the Drawing Toolbar.

**Note** Draw remembers the last selected Shape.

2) Select the desired shape.

- To draw an Ellipse.

- To draw a Perfect Circle.

- To draw a Rectangle.

- To draw a Square.

- To draw a Triangle.

- To draw a Right Triangle.

- To draw a Pentagon.
• To draw a Polygon.

• To draw a Filled Ellipse.

• To draw a Filled Perfect Circle.

• To draw a Filled Rectangle.

• To draw a Filled Square.

• To draw a Filled Triangle.

• To draw a Filled Right Triangle.

• To draw a Filled Pentagon.
3) If you have selected a non-filled shape; select the desired border width by clicking on the border width arrow and selecting a size from the drop-down list.

**Note** Draw remembers the last selected border width

![Border Width selector](image)

4) Select the desired colour.

5) Touch the TeamBoard and drag along the TeamBoard until you have created the shape you desire. TeamBoard Draw will preview the shape and draw it when you are done.
**Entering Text**

**Tip** You can also copy text from other applications and paste it into TeamBoard Draw (page 74.)

1) Select the Text Options icon on the Drawing Toolbar.

**Note** Draw remembers the last selected Text Option.

![Text Options on the Drawing Toolbar](image)

2) Select the Text Tools icon.

![Text Tools](image)

3) Touch in the drawing area where you would like to place the text.

*TeamBoard Draw displays the Edit Text window.*

![Edit Text](image)

4) Select the desired font from the drop-down list.

![Font drop-down list](image)
5) Select the desired text size from the Font Size drop down list.

6) Select the desired Bold, Italic, and Underline style selections.
   - To select a style, tap its button once.
   - To deselect a style, tap its button once.
7) Select the desired colour.

8) Enter text in the text box
   - To use your computer’s keyboard, start typing in the box.
   - To use the virtual keyboard, press the virtual keyboard button.

   Virtual Keyboard

   Windows 7 Virtual Keyboard

   **Tip**
   Press enter to insert a new line

9) Once you are finished entering text press the OK button to insert the text

   *The text is inserted into TeamBoard Draw*
Cut, Copy, Paste and Moving Objects

Moving Content

Tip In TeamBoard Draw every pen line, creative pen line, shape, clipart and text line is a moveable object.

Tip To move TeamBoard Draw objects to a different TeamBoard Draw page or another software application use the Copy, Cut and Paste tools (page 74.)

1) Select the Move Options icon from the Drawing Toolbar.

Note Draw remembers the last selected Move Option.

Move Options

2) Select the Object-Move tool

Object-Move

3) Press the item you want to move and drag it to the desired location.

The object is moved to the new location.

Copying, Cutting, and Pasting Content

Copying and Cutting

Use the cut option to remove TeamBoard Draw objects from their current positions and place them onto the clipboard, so that they can be pasted onto a different TeamBoard Draw page or into another software application. Use the Copy option to do the same, while leaving the original objects in their current positions.

1) Select the Clipboard Tools icon from the Drawing Toolbar.

Note Draw remembers the last selected Clipboard Tool.
2) Select the desired copy or cut option.
   • To copy multiple objects at the same time, select Multi-Copy
     \[\text{Multi-Copy}\]
   • To copy a single object, select Object-Copy
     \[\text{Object-Copy}\]
   • To cut multiple objects at the same time, select Multi-Cut
     \[\text{Multi-Cut}\]
   • To cut a single object, select Object-Cut
     \[\text{Object-Cut}\]

3a) Multi-Copy or Multi-Cut Tools
   • Select a large area around the objects you wish to copy or cut, then drag your finger along that area until the objects are encompassed. \textit{Objects that are only partially encompassed are not selected for the move or copy. If you miss selecting some objects, simply reselect a larger area.}

3b) Object-Copy or Object-Cut Tool
   • Tap the object once to copy or cut

\textbf{Pasting}

\textbf{Important} To paste, you must have copied or cut objects from either TeamBoard Draw or another application, onto your clipboard.

1) Display the TeamBoard Draw page you want paste onto.
2) Select the Clipboard Tools icon from the Drawing Toolbar.

\[\text{Clipboard Tools on the Drawing Toolbar}\]
3) Select Paste.

TeamBoard Draw will paste the object(s) from the clipboard onto your current TeamBoard Draw page.

Tip Use the move tools to move pasted objects (page 74.)
Working with Multiple Pages

Creating a New, Blank Page

The Insert Page button on the TeamBoard ActionBar or the TeamBoard Draw Virtual ActionBar is the quickest way to get a blank new page in TeamBoard Draw.

1) Select Insert Page on the TeamBoard ActionBar or on the TeamBoard Draw Virtual ActionBar.

A new, blank page is inserted. All drawings on the previous page(s) are saved.

Tip
You can also insert a new page by:

i. Click the Insert Page button on the Page Sorter (page 78.)

ii. Right click in a blank area of the TeamBoard Draw Workbook. Select Insert Page (page #.)
Creating a Copy of a Page

TeamBoard Draw allows you to copy the current page and create a new, identical page following it. The Copy Page button on the TeamBoard ActionBar or on the TeamBoard Draw Virtual ActionBar is the quickest way to copy a page to work with.

1) Select Copy Page on the TeamBoard ActionBar or the TeamBoard Draw Virtual ActionBar.

A new, duplicate page is inserted. All drawings on the previous page(s) are saved.

Deleting a Page

Important This action cannot be undone.

1) Select the page you want to delete.

Tip You can also delete a page by pressing the Delete key on your keyboard

Using the Page Sorter

Closing the Page Sorter

1) To close the Page Sorter select View > Page Sorter.

Note If you close the Page Sorter it remains closed the next time you launch TeamBoard Draw.
Opening the Page Sorter

1) To open the Page Sorter select View > Page Sorter

![Page Sorter Open]

Sorting Pages

There are two ways to sort pages with the Page Sorter.

Drag and Drop

1) Press the page you wish to move

2) Drag the page up or down the Page Sorter until it is in the location where you want it to be placed.

3) Release your finger.

The page is placed in the specified location.

Buttons

1) Click the page you want to move.

Note: Draw will place a red border around the page

![A Selected Page in the Page Sorter]
2) Move the page in the desired direction
   a. If you want to move the page up the Page Sorter select the Move Up button

   ![Move Up]

   b. If you want to move the page down the Page sorter select the Move Down button

   ![Move Down]

**Viewing Pages**

There are two ways to view pages with the Page Sorter.

**Page Sorter**

1) Click on the page you wish to view

   ![A Selected Page in the Page Sorter]

*The page is displayed.*

**Keyboard**

1) Using your keyboard or the virtual keyboard:
   a. Press the up key to move up one page
   b. Press the down key to move down one page

*The page is displayed.*
Saving Your Work

Manually Saving

TeamBoard Draw allows you to save your work as a TeamBoard Draw file (.tmb.) If you wish to save the file in another format use the Export feature (page 84.)

1) Select File > Save As.

The Save As dialog box will display.

2) Browse for the location where you wish to save the file.

3) Click the File Name field and use the Virtual Keyboard or the computer keyboard to type out a file name.

Save As window with the File Name filled out
4) Click Save

*TeamBoard Draw saves the file*

**Tip** You can also save by:
   a. Selecting the Save icon on the Standard Toolbar

   ![Save Icon](image)

   **File > Save**

   b. Clicking File > Save

**Auto Save**

Use the auto-save feature to automatically save the current workbook at a specified time interval. By default, this feature is disabled. Use the following procedure to enable Auto-Save and specify the interval.

1) Select Tools > Options

![Tools > Options](image)
2) Click the Autosave tab

3) Enter the desired time interval in the Auto-Save Interval (mins) text box.

Click OK. TeamBoard Draw changes the auto save time.
Exporting a Page or Workbook

TeamBoard Draw allows you to export your TeamBoard Draw workbook or page into a variety of formats. If you wish to save your file to work on later or to re-open you should save it (page 81.)

Supported Export Formats

A TeamBoard Draw workbook or page can be exported to the following file types:

- JPEG
  - .jpg
- Bitmap
  - .bmp
- Portable Network Graphic
  - .png
- HTML
  - .html
- Tagged Image Format
  - .tif
- Portable Document Format
  - .pdf
- PowerPoint Presentation (2003 or older only)
  - .ppt
- Interactive Whiteboard File Format
  - .iwb

Exporting your Current Page

1) Display the TeamBoard Draw page you wish to export (page 77.)
2) Select File > Export > Page

Draw will display the Export dialog box.
3) Browse to the location where you want your exported file to be placed

![Export Window](image1.png)

4) Click the File Name field and use your keyboard or the virtual keyboard to enter the desired file name.

5) Select the desired Save As Type.

![Save As Type selection](image2.png)
6) Click Save

Your file is created and placed into your chosen location

**Exporting the TeamBoard Workbook**

1) Select File > Export > Workbook

   ![Export Workbook](image1)

   *Draw will display the Export dialog box.*

2) Browse to the location where you want your exported file to be placed

   ![Export Window](image2)

   *Export Window*

3) Click the File Name field and use your keyboard or the virtual keyboard to enter the desired file name.
4) Select the desired Save As Type.

![Save As Type selection](image)

5) Click Save

*Your file is created and placed into your chosen location*

**Printing Your Work**

**Print Preview**

Print Preview is a quick way to view exactly what the current page will look like when you print it out.

**Opening Print Preview**

1) On the Standard Toolbar click the Print Preview button

![Print Preview](image)
The Print Preview window will open.

**Closing Print Preview**

1) On the Print Preview window click the Close button

The Print Preview window closes.

**Printing**

1) Click the Print button on the TeamBoard ActionBar or TeamBoard Draw Virtual ActionBar

Your TeamBoard Workbook will print to the default printer
Advanced Printing

1) Press the Print button on the Standard Toolbar

[Image: Print]

The Print window will open.

2) Modify the print job properties as required

[Image: Print Window]

3) Press OK

Your TeamBoard Workbook will print to the specified printer.

Tip You can also print by clicking File > Print

[Image: File > Print]
Full Screen Mode

Full Screen Mode hides the title bar, menu bar, page sorter and standard toolbar to allow you to have more drawing area.

Opening Full Screen Mode

1) On the Standard Toolbar select the Full Screen button

[Image of Full Screen button]

Full Screen Mode will launch.

Full Screen Drawing Toolbar

The Full Screen Drawing Toolbar is the same as the normal Drawing Toolbar except it has six additional buttons to make working in full screen mode easier.

[Image of Full Screen Drawing Toolbar]

The TeamBoard Draw Full Screen Drawing Toolbar with a TeamBoard 3

The TeamBoard Draw Full Screen Drawing Toolbar Six Additional Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Erases the last change done to the Workbook</td>
</tr>
<tr>
<td>Redo</td>
<td>Undoes the last Undo action</td>
</tr>
<tr>
<td>View Grid</td>
<td>Displays grid lines to assist you with drawing</td>
</tr>
<tr>
<td>Go to Previous Page</td>
<td>Displays the preceding page</td>
</tr>
<tr>
<td>Go to Next Page</td>
<td>Displays the following page</td>
</tr>
<tr>
<td>Return to Draw</td>
<td>Closes full screen mode and restores TeamBoard Draw</td>
</tr>
</tbody>
</table>
Clipart

Opening ClipArt Viewer

1) On the Standard Toolbar select the ClipArt Viewer

ClipArt Viewer

The ClipArt Viewer displays on the right (by default.)

ClipArt Viewer on a Windows system

2) Navigate through the image collections to find the graphic or movie you want.
   • To find images select a category or open a folder and select a category
3) Click the graphic or movie you want to add to your TeamBoard Draw workspace and drag it into the drawing area. Release your finger to add it.

*The image or movie will be added to your drawing area.*

**Tip** To adjust the image use the Move tool (page 74.)

**Adding a Category to ClipArt Viewer**

1) Click Add a Category

![Add a Category](image)

*Add a Category*

2) In the Add a Category menu select Add a Category

![Add a Category in Add a Category menu](image)

*Add a Category in Add a Category menu*

A *new category is created.*

![New category](image)

*New Category*

3) Using the keyboard or Virtual Keyboard type a name for the new category. Press Enter to save the name.

*The New Category is saved.*
Importing an Image into ClipArt Viewer

About Importing an Image into ClipArt Viewer

TeamBoard Draw allows you to import movies and images to the ClipArt Viewer for easy access.

ClipArt viewer supports the following file types:

- JPEG
  - .jpg
- Graphic Interchange File
  - .gif
- Bitmap
  - .bmp
- Portable Network Graphic
  - .png
- Scalable Vector Graphic
  - .svg
- Tagged Image Format
  - .tif
- Icon
  - .ico
- Audio Video Interleave
  - .avi
- Quicktime File Format
  - .mov
- Moving Picture Experts Group
  - .mpg
- Adobe Flash
  - .swf

Importing an Image into ClipArt Viewer

1) Select the category you want to place the image into
   - If you do not see the category you want you should create a category (page 92.)

2) Click Add a Category
3) In the Add a Category menu select Import

The Import window will open.
4) Navigate to the image or movie you want to import. Click to select the image. Click Open to import the image.

*Import window with a picture selected*

*The image is imported.*

*ClipArt Viewer with imported image*
Deleting a Category ClipArt Viewer

1) Select the category you want to delete.

2) Click Add a Category

3) In the Add a Category menu select Remove a category

*The category is removed.*

Moving ClipArt Viewer

ClipArt Viewer allows you to switch which side it appears on. By default it appears on the right hand side.

1) Select the Move ClipArt Viewer button

*ClipArt Viewer is moved to the opposite side.*
Closing ClipArt Viewer

1) On the ClipArt Viewer click the Close ClipArt Viewer button

*Close ClipArt Viewer*

*The ClipArt Viewer is closed*
Spotlight

The spotlight tool lets you shine a spotlight on an area of the TeamBoard to help direct your audience’s attention.

Opening the Spotlight

1) Click the Spotlight icon on the Drawing Toolbar

\[ \text{Spotlight} \]

*The Spotlight turns on.*

2) Touch the board anywhere you want the spotlight or move it by dragging it.

*The spotlight moves wherever you touch.*

3) To exit the spotlight, double-click anywhere on the board.

Adjusting the Spotlight

Making the Spotlight Larger

1) Drag the edge of the Spotlight outward, the Spotlight increases in size.
**Making the Spotlight Smaller**

1) Drag the edge of the Spotlight inwards, the Spotlight decreases in size

**Changing the Spotlight Shape**

TeamBoard Draw offers you three different spotlight shapes to choose from.

1) Using your mouse, right click anywhere on the screen

*The Change Spotlight Shape menu appears*

![Change Spotlight Menu](image)

2) On the Change Spotlight Shape menu select the spotlight shape you want

- Oval Spotlight

![Oval Spotlight](image)

- Rectangle Spotlight

![Rectangle Spotlight](image)

- Star Spotlight

![Star Spotlight](image)

*The Spotlight is changed to the selected shape.*
Changing the Spotlight Background Colour

1) In TeamBoard Draw select the Tools menu and within that select the Options button

![Options]

*TeamBoard Draw Options opens.*

2) On the TeamBoard Draw Options window select the Spotlight Options tab.

![Spotlight Options]

*Spotlight Options*
3) Select the Spotlight background colour
   a. If you want to use a standard colour, select a colour from the Standard Colour dropdown

![Standard Colour Dropdown](image)
b. If you want to use a custom colour:
   i. Click the custom colour icon

   ![Custom Colour]

   ii. On the TeamBoard Custom Colour window select the colour you desire

   ![TeamBoard Custom Colour window]

   iii. Click OK to select the custom colour

4) Click OK

*The spotlight background colour will change.*
Using Hide/Reveal

The Hide/Reveal tool lets you show or hide any part of the screen you want. Use it to temporarily hide an item you are not ready to show yet.

1) From the Drawing Toolbar, select the Hide/Reveal tool.

\[\text{Hide/Reveal}\]

*The Hide/Reveal hides your entire page.*

2) Resize the hide screen by dragging the adjustment grabbers.

\[\text{Adjustment Grabbers}\]

**Tip** To exit; double click the Hide/Reveal screen.

Inserting Backgrounds

Inserting Background from File

1) In Draw, display the page where you want to change the background (page 77.)

2) Select Insert > Background > From File

\[\text{Insert Background from File}\]

*The Import window displays*
3) Browse for the file you wish to use. Click to select the image and click Open to insert it.

![Import Window](image)

4) A window will appear asking you how you wish the background to look

![Background Window](image)

**Background Position**
- **Stretch** will stretch the picture so that it fills the entire background of the Drawing area
- **Scale** will stretch the picture so that it fills the entire background of the Drawing area while maintaining the aspect ratio
- **Tile** will place multiple copies of the image as the background so that it is filled without stretching the image
Center will place the image in the center of the Drawing area and leave blank space if it doesn’t fill the entire space.

Page Settings

Apply to current page will use the image for the background of the page you’re currently viewing only.

Apply to all pages will use the image for background for all pages, both those already created and any more you create.

5) After you have made your selections press OK. TeamBoard Draw will insert the image as the background.

Insert Background Colour

1) In Draw, display the page you want to change the background colour of (page 77.)

2) Select Insert > Background > Background Colour

The TeamBoard Custom Colour window opens
3) Select the background colour you desire.

![TeamBoard Custom Colour Window]

4) After you have made your selection press OK. The Background window will appear.

![Background Window]

5) Select how you want to apply the background and then press OK:
   - **Apply to current page** will use the background for the page you’re currently viewing only.
   - **Apply to all pages** will use the background for all pages, both those already created and any more you create.

*TeamBoard Draw will insert the colour as the background.*
Deleting an Imported Background Image

1) In TeamBoard Draw, display the page with the background image you want to remove (page 77.)

2) Select Edit > Clear Background.

The background image is removed from your current TeamBoard Draw page.

Importing Files Images into TeamBoard Draw

Importing an Image from a Graphic File

1) In Draw, display the page you want to import into (page 77.)

2) Select Insert > Picture > From file...

The Import window displays
3) Browse for the file you wish to import. Click to select it and click Open to insert it.

*Import window on a Windows system with a picture selected*

*The Image is inserted into TeamBoard Draw*

**Tip** Use the Move Tools to move and manipulate the image (page 74.)
**Importing a Movie**

You can import movies into TeamBoard Draw allowing you to play or pause, rewind, or fast forward the movie all from the TeamBoard. You can also manipulate the movie by using the move tools.

**Supported Formats**

You can import a movie with one of the following extensions:

- .swf
- .avi
- .mov
- .3gp
- .mpg
- .mpeg
- .mp4

**Important** You must have Adobe Flash (for .swf files) and Apple QuickTime installed to view movies (page 8.)

**Importing a Movie**

1) In Draw, display the page where you want to add a movie (page 77.)

2) Select Insert > Movie
3) Browse for the file you wish to import. Click to select it and click Open to insert it.

![Import window with a Movie selected]

*The Movie is inserted into TeamBoard Draw*

**Tip** Use the Move Tools to move and manipulate the image (page 74.)
Chapter 9 – Using TeamBoard to Annotate

About Annotate

Annotate is designed to be used in Interactive Mode. It gives the user the ability to mark up applications and presentations projected onto the TeamBoard. For example, you can draw a circle around an important point or underline items.

When you use Annotate, all of the drawing, writing and editing features of TeamBoard Draw are available to you. Furthermore, once your Annotated file is saved into TeamBoard Draw, the saving and importing features are also available.

Launching Annotate

1) Double click the TeamBoard System Tray Icon.

![TeamBoard System Tray Icon on a Windows 7 System](image)

The TeamBoard Dashboard displays.

![TeamBoard Dashboard](image)

**Note** Mode will not appear if a TeamBoard IR or TeamBoard Touch Monitor is connected.
2) Click the Annotate button on the TeamBoard Dashboard.

3) The AccessBar will display.

Tip
You can also launch Annotate by:
- pressing a pen on the ActionBar (interactive mode only)
- opening the System Tray Menu and selecting Annotate
- pressing the Annotate button, to the left of the Standard and Drawing toolbars, in Draw

The AccessBar Explained

On the AccessBar you will see six options.

<table>
<thead>
<tr>
<th>Icon</th>
<th>The T Icon</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="T Icon" /></td>
<td>Shrinks or expands the Access Bar</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Full Screen Annotate" /></td>
<td>Captures the entire screen so you can annotate on top of it</td>
<td>113</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Area Annotate" /></td>
<td>Captures an area of the screen so you can annotate on top of it</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Draw" /></td>
<td>Closes the AccessBar and Annotate Mode and returns you to TeamBoard Draw</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Virtual Keyboard" /></td>
<td>Open the virtual keyboard</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Folder Drop Down Box" /></td>
<td>Access pre-programmed macros</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Using Annotate

Capturing Screens for Use with Annotate

1) Launch Annotate

2) Display the screen you want to annotate.

*Work with your computer and any applications as required until you are ready to capture the screen image for use with Annotate.*

3) Select the Full Screen Annotate button on the AccessBar.

   ![Full Screen Capture](image)

   *Wait a moment as an image of your screen is captured into TeamBoard Draw. Once in Annotate, the TeamBoard Draw Drawing Toolbar displays.*

   ![Annotate Toolbar](image)

   **Note** All of the drawing and editing features of TeamBoard Draw are available on the Annotate Toolbar

4) Begin marking up your snapshot on the TeamBoard.

5) When finished annotating, select the Return to Desktop button on the Drawing Toolbar

   ![Return to Desktop](image)

   *Annotations are saved in TeamBoard Draw and you are returned to the application that was active when the annotation began*

6) Repeat step 2 to step 5 to annotate another screen.

7) When you are finished with Annotate, select the Return to Draw button on the Drawing Toolbar.

   ![Return to Draw](image)
Capturing an Area for Use with Annotate

1) Launch Annotate

2) Display the screen you want to annotate.

*Work with your computer and any applications as required until you are ready to capture the screen image for use with Annotate.*

3) Select the **Area Capture** button on the AccessBar.

4) In the box that drops down select the type of Area Capture you’d like to use

- **Freehand**
  - Allows you to draw around the area you wish to capture, allowing for any size or shape
- **Rectangle**
  - Allows you to capture an area using a rectangle shape

5) Touch the TeamBoard and drag along it until you have contained the area you wish to capture within the dashed line.

6) Release your finger off the TeamBoard.

*Wait a moment as an image of your screen is captured into TeamBoard Draw.*

7) Repeat step 1 to step 6 to annotate another screen.

8) When you are finished with Annotate, select the **Return to Draw** button on the Drawing Toolbar.
Using the ActionBar with Annotate

1) Display the screen you want to annotate.

*Work with your computer and any applications as required until you are ready to capture the screen image for use with Annotate.*

2) Press an ActionBar pen colour button.

*Wait a moment while Annotate is launched.*

3) Begin marking up your snapshot on the TeamBoard.

4) When finished annotating, select the New Page button on the TeamBoard ActionBar.

![New Page Button](image)

*This captures the annotations to a page in TeamBoard Draw. You are returned to the application that was active when the annotation began.*

5) Repeat steps 1 to 4 to annotate another screen.

6) When you are finished with Annotate, select the Return to Draw button on the Drawing Toolbar.

![Return to Draw](image)
Chapter 10 – TeamBoard 3 VRT Special Features

About TeamBoard 3 VRT Special Features

When you connect a TeamBoard 3 VRT you unlock additional tool features in TeamBoard Draw that allow you to use the pressure sensitivity to work in TeamBoard Draw. These tools are called 3D tools.

Additional features enabled by connecting a TeamBoard 3 VRT include dual user mode and hover.

Hover

As soon as you connect your TeamBoard 3 VRT you enable the hover feature. If you lightly drag your finger across the TeamBoard your mouse cursor will follow your finger around your screen. This allows you to navigate web pages and your desktop easily.

Dual User Mode

Connecting a TeamBoard 3 VRT to your computer will enable Dual User mode in TeamBoard Draw. In Dual User mode you and a friend can work simultaneously in TeamBoard Draw (one person draws on the left side and the other draws on the right side.) To change your tool, select a different tool on the respective side of the dual toolbar.

Opening Dual User mode

1) Open TeamBoard Draw

2) On the Standard Toolbar click the Switch Toolbar button

Switch Toolbar
The Dual Toolbar opens

Dual Toolbar

TeamBoard Draw is placed in Dual User mode

3D Tools

In both Dual and Standard mode, with a TeamBoard 3 VRT connected, 4 tools in TeamBoard Draw are changed to make your experience easier.

Solid Line Pen

With a TeamBoard 3 VRT connected the Solid Line tool transforms into a pressure sensitive pen. The harder you push on the TeamBoard the thicker the drawn line is; the lighter you touch on the TeamBoard the thinner the line is.

Enabling 3D Solid Line Pen

1) On the toolbar press the 3D button.

The Solid Line Pen is changed to 3D Solid Line Pen

Tip To disable 3D simply press the 3D button again.
Small Eraser

The Small Eraser is automatically transformed into a pressure sensitive eraser as soon as your TeamBoard 3 VRT is connected. The harder you push on the TeamBoard the larger eraser becomes; the lighter you touch the smaller the eraser is.

Object Move

With a TeamBoard 3 VRT connected the Object Move tool transforms into a pressure sensitive layer adjustment tool. When you touch lightly on the TeamBoard the object is moved up one layer (towards the top layer); when you touch harder the object is moved down one layer. There are three colours used to easily identify which layer the object is on:

- Red – The lowest layer
- Yellow – The middle layer
- Green – The top layer

Enabling 3D Object Move

1) On the toolbar press the 3D button.

Object Move is changed to 3D Object Move

Tip To disable 3D simply press the 3D button again.

Spotlight

The Spotlight can be adjusted with pressure when you connect your TeamBoard 3 VRT. Touch the edge of the spotlight lightly and the spotlight will shrink, press harder and the spotlight will increase in size.
Chapter 11 – Controlling Applications with TeamBoard

Programming the ActionBar

Windows XP, Windows Vista, Windows 7, Windows 8

TeamBoard Suite includes the ActionBar Editor, a program designed to allow you to easily change what the ActionBar buttons do in each program.

Opening the ActionBar Editor

1) Open the TeamBoard Start Menu Folder

2) Select ActionBar Editor

The ActionBar Editor opens

![The ActionBar Editor with a TeamBoard 3 VRT](image)

The ActionBar Editor with a TeamBoard 3 VRT
Programing an ActionBar Button

1) Select the button you want to program

```
Button

<table>
<thead>
<tr>
<th>Button</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Button1</td>
<td></td>
</tr>
<tr>
<td>Button2</td>
<td></td>
</tr>
<tr>
<td>Small eraser</td>
<td></td>
</tr>
<tr>
<td>Large eraser</td>
<td></td>
</tr>
<tr>
<td>Black pen</td>
<td></td>
</tr>
<tr>
<td>Red pen</td>
<td></td>
</tr>
<tr>
<td>Green pen</td>
<td></td>
</tr>
<tr>
<td>Blue pen</td>
<td></td>
</tr>
<tr>
<td>Add document</td>
<td></td>
</tr>
<tr>
<td>Next document</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>First</td>
<td></td>
</tr>
<tr>
<td>Back</td>
<td></td>
</tr>
<tr>
<td>Forward</td>
<td></td>
</tr>
<tr>
<td>Last</td>
<td></td>
</tr>
<tr>
<td>Button18</td>
<td></td>
</tr>
<tr>
<td>Button19</td>
<td></td>
</tr>
</tbody>
</table>
```

2) Select the program you want to use with ActionBar
   a) If you want the ActionBar button to work in any program (except TeamBoard Draw) select Any

```
Program

<table>
<thead>
<tr>
<th>Name</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>
```

“Any” program selected
b) If want the ActionBar button to work with a specific program, select the program from the “Program” list
   - If you do not see the program you want in the list you will need to add it to the list
     1) Click the Add a Program button at the bottom of the Program list

   The Add a Program button

   The Add Program window opens

   ![Add Program window]

   2) In the Program field type the name you wish to appear for the Program

   ![Program field filled out]
3) In the File field either type out the location of the program or click the box to the right of the field to browse for the program.

   Browse Box

   The Open window appears

4) Browse to the location of the program

   Browsing to the location of the program

5) Select the program and click Open

   Program selected
6) Click the check mark to add the program to the list of programs

Program added to the list of Programs

The program is automatically selected.

3) Select the version of the Program you want to use with the ActionBar
   a. If you don’t have multiple versions of the program on the computer or you want the button to work with all versions of the program select “Any”
b. If want the ActionBar button to work with a specific version of the program, select the program version from the “Version” list
   • If you do not see the program version you want in the list you will need to add it to the list

   **Note** Use the up and down arrows to prioritize the versions you have entered.

   1) Click the Add a Version button at the bottom of the Version list

   ![Add a Version button]

   *The Add a Version button*

   *The Add a Version window opens*
2) In the Version field type the version number you wish to appear for the Version
   a) If you know the version number of the program type it into the Version field.
   
   b) If you do not know the version number of the program you will need to determine it
      i. Open the location of program executable
      ii. Right click on the executable and select Properties
      iii. On the properties window select the Details tab
      iv. The version number is the number located in the File version field

![The Properties window on Windows 7](image)
v. Type the File version number into the Version field in the ActionBar Editor

3) In the language field type the two digit language code for the version. To determine which language code to use, go to:
4) Click the check mark to add the version to the list of versions

Version

<table>
<thead>
<tr>
<th>Version</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.0.7601.17514</td>
<td>EN</td>
</tr>
<tr>
<td>Any</td>
<td>Any</td>
</tr>
</tbody>
</table>

Version added to the list of versions

The version is selected.
4) Select the Action you wish occur when the ActionBar button is pressed.
   a. Keys
      a) Used to send keystrokes when the button is pressed

      **Note**
      The strings "Ctrl", "Shift", "Alt" and "Meta" are recognized

      **Tip**
      A comma is used to separate keystrokes
      - Example
        Ctrl+S, Ctrl+P, Alt+C

   b. API
      Application Programming Interface
   c. Command
      a) Used to run a program or script, open a program, or execute any other command line query
         - Example
           C:\shutdowncomputer.bat

      **Tip**
      You can browse for the application or script you’d like to run with the browse button

      ![Browse Button]

   d. Document
      a) Used to open documents or webpages

      **Tip**
      You can browse for the document you wish to open with the browse button

      ![Browse Button]

5) Repeat steps 1-4 to program other ActionBar buttons

6) Once you are finished programming the buttons click the green checkmark to save and exit.

   ![Save and Close checkmark]